USB TO RS-232 ADAPTER

User’s Manual

UMC-201XS / UMC-102XS / UMC-104XS / UTS-232X45
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1. Introduction

Universal Serial Bus (USB) port technology has emerged in response to the proliferation of external peripheral
devices (scanner, digital camera, portable hard-disk drive, cell phone, PDA, MP3 player, etc.) that are increasingly
being connected to the latest generation of PCs. The USB behaves in a similar fashion to conventional bus ports
like Serial (COM) and PS/2. As it doesn’t require any IRQs, more devices can be attached to the system without
conflicts.

This USB to Serial converter provides an external plug-and-play connection for RS-232 enabled devices with PC or
any computerizing devices that support the USB specification. The converter comes with the standard connectors
of Serial DB-9 and USB Type A or B to fulfill your working requirements. With the link of USB to Serial cable,
communication starts interacting without any barriers.

For further convenience, this product is designed to work by using the power drawn from the Universal Serial Bus
and no external power is required. As it is an USB compliant device, features of plug and play, hot-swapping, energy-
saving suspend, and resume are provided.

Since the most computers have limited USB and COM ports, USB hubs can be employed to gain more USB ports
for numerous USB peripheral devices to be connected up with your PC at the time.

System Requirements

Windows OS : 98SE / Me / 2000 / XP / Vista /7 /8 /8.1 /10 or higher
Windows Server 2003 / 2008 / 2008R2 / 2012 / 2012R2 / 2016 / 2019 or higher
WinCE OS: V4.2 ~ V7.0

Mac OS: 8.6/ 9.x/10.x/ 11 or higher

Linux OS: Kernel 1.5.0 or higher

The system is equipped with USB Host Controller
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Features

Fully Compliant with USB Specification 1.1 /2.0

Supports the synchronous and asynchronous serial interfaces.

Supports remote wake-up and power-on-reset

+15kV HBM ESD protection

512 byte receive buffer and 512 byte transmit buffer utilizing buffer smoothing technology to allow for high data
throughput.
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Specification

Model No. UMC-201XS | UMC-102XS | UTS-232X45 | UMC-104XS
Chip FTDI
USB Specification USB 1.1 /2.0 compliant
USB 1.5/ 12 Mbps
Data Speed Serial Up to 230 kbps
Connector Hosf[ USB A/M USB B/F
Device DB-9Male | DB-9Male*2 | RJ45 Male DB-9 Male*4
Operating Temp. 0°C ~40 C
Environment | Storage Temp. -20 C ~60 C
Humidity 0~80% RH, Non-condensing
Power Mode Bus powered
Cable Length 1.1m 0.6m 1.8 m 1.8 m
Housing PVC Plastic PVC Aluminum

RS-232 Pin Assignment

DB-9
Pin No. Definition Description
1 DCD Data Carrier Detected
2 RxD Receive Data
3 TxD Transmit Data
4 DTR Data Terminal Ready
5 GND Signal Ground
6 DSR Data Set Ready
7 RTS Request To Sent
8 CTS Clear To Sent
9 RI Ring Indicator

RJ-45 Pin Assignment

1234567 B 8 7 6543 2 1 Pin  Signal
1 vcc
2 RX
3 CTS
4 RTS
5 X
6 GND
7 NC
8 NC

Rj-45 Jack Rj-45 Plug
(Female) (Male)



2. Windows OS Installation Guide

Driver can be installed through Windows Update automatically (Internet connection needed)

The FTDI drivers that have passed the WHQL tests are available for download using Windows Update.
OS requirements: Windows 7/8/8.1/10 or later.

Please go below ways for easy installation.
1. You may plug the device into host computer. And then it will pop up ‘Installing device driver software’ from the

taskbar of the screen. (Fig. 1) Click and connect to the Windows Update.

2. It will check your computer OS and download the applicable driver at the Windows Update automatically.

&

Installing device driver software * *
Click here for status.

Fig. 1

3. The program goes ‘Searching Windows Update’ from ‘Driver Software Installation’. (Fig. 2)

" Driver Software Installation

Installing device driver software

Generic USE Hub o U5
USE <-= Serial i_J Searching Windows Update...

Obtaining device driver software from Windows Update might take a while,
Skip cbtaining driver software from Windows Update

Fig. 2

4. When the applicable driver is detected, it will run ‘Installing device driver software’. (Fig. 3)

-
_'_! Driver Software Installation

Installing device driver softwage

USB <-> Serial | {_Searching preconfigured driver folders... II

Fig. 3




5. Then it shows ‘USB Serial Port (COM8) installed’. Click ‘Close’ and go next step. (Fig. 4)

.
| Driver Software Installation

Your device is ready to use
e
USE Serial Converter JReady to use
USE Serial Port (COMS) JReadyto use

Fig. 4

6. Check ‘Device Manager’ of Control Panel from the computer OS and there shows USB Serial Port (COMS8) under
‘Ports (COM & LPT)’; the other one shows USB Serial Converter under ‘Universal Serial Bus controllers’. (Fig. 5)
Congratulation! You have finished installing the USB to Serial device successfully.

rﬁ Device Manager R E@Iﬂ
File Action View Help
e M E HE & E%S

5 ¥ Network adapters B

JEI Portable Devices
477 Ports (COM & LPT)

= USE Serial Port (COMS)

'> D Processors
b -% Sound, video and game controllers
l - 78 Systemn devices

ai “ Universal Serial Bus controllers

..... § Generic USB Hub

L]/ § Generic USB Hub

..... § Generic USE Hub

..... § USB Root Hub

..... § USB Root Hub

..... § USE Root Hub

..... § USB Root Hub

..... § USE Root Hub

..... § USE Root Hub

..... USE Root Hub

m

Usb oo
E UUSB Serial Converter
0

PP et [T A

1 nmeTeo 1icn P |

Fig. 5

NOTE: It may occur when driver is not installed successfully, please check below steps.
1. There is busy on access databank of Microsoft’s Support link. Please try again or install driver of CD-ROM

provided.
2. Check your internet if it is failed to access Microsoft's Support link.
3. Check your computer configuration if it is disabled on Windows Update wizard.

-
Device driver software was not successfully installed

Please consult with your device manuficturer for assistance getting this devicginstalled.

USB <-» Serial I Mo driver found

What canldo if my device did not install properly?

Close




3. Driver Installation thru the FTDI Driver Package
Driver can be installed through the FTDI driver package of the CD-ROM provided.

3.1. Double click ‘Setup_v2.12.00 WHQL Certified For Windows OS_x86.x64.exe’

J f -' é ‘ '

Linux(1.5.00 Mac Q% 8.9 Mac 05 X109 Windows Windows
and above(2.3) 98ME(1.09.06) 2000(2.06.00)

TNk

m

1 _ |
i I

Windows CE Windows RT XP,2003,Vista#0 | Setup v2.12.00
42-52 6.0 Mo 08,7,8,8.1,200BR | WHQL Certified
bile 2,2012R2(2.180 For Windows
2003,20035E,5... 0) | OS_xB6.x64 exe

3.2. It will pop up FTDI CDM Dirivers’ from the screen. Click ‘Extract’ and go next step.

FTDI CDM Drivers

Click 'Extract’ to unpack version 2.12.00 of FTDI's Windows
driver package and lsunch the installer.

www ftdichip.com

Cancel




3.3. Extracting Files

[ ™

Extracting Files
FreeExtractor is extracting the compressed files in this archive.

Please wait while the files in this archive are extracted.

Extracting Static/i386/ftd2xc.lib ...

| | Cancel

3.4. Click ‘Next” to continue.
- _
Device Dnver Installation Wizard

-

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to wark.

To continue, click Mext.




3.5. Select ‘I accept this agreement’ and click ‘Next'.

Device Dniver Installation Wiza

To continue, accept the following license agreement. To read the entire
= agreement, use the scroll bar or press the Page Down key.

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE -
INSTALLING THE RELEVANT SOFTWARE: |:|
This licence agreement (Licence) is a legal agreement between you
(Licensee or you) and Future Technology Devices Intemational Limited

of 2 Seaward Place, Centurion Business Park, Glasgow G41 THH,

Scotland (UK Company Number SC136640) (Licensor or we) for use of
driver software provided by the LicensonSoftware).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE ~

@ | accept this agreement! [ Save As ] [ Brint
") | dont accept this agreement

Meat > ]

3.6. The Device Driver Installation Wizard will detect your computer OS and install the applicable driver
automatically.

Iievice Driver Betinie

The drivers are now installing...

- &

s -

Flease wait while the drivers install. This may take some time to complete.




3.7. While the Device Driver Installation Wizard is completing, click ‘Finish’ to exit.
Device Driver Installaticn Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

w" FTDI COM Driver Package - Bus/D2X... Readyto use
w"' FTDI COM Driver Package - VCP Driv...  Readyto use
4 1

4. Driver Installation
Windows 98 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the uninstalling
instruction.

Download the latest available drivers from the FTDI website and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. This will launch the Windows Add New Hardware
Wizard. Windows may display a message reading "Building driver database" at this point which may take
a few minutes to pass. Click "Next" to proceed with the installation.

Add New Hardware Wizard

This wizard zearches for new drivers for:

USE <-> Serial Cable

A device driver iz a software program that makes a
hardware device work.

< Back Cancel




Select "Search for the best driver for your device (Recommended)" as shown below and then click "Next".

Add New Hardware Wizard

YWhal do you want Windows to do’?

o ESearch far the best driver for yaur dewvice. ;
{{Recommended).

" Display a list of all the drivers in a spectic
lozation, 20 pou can zelect the driver pou want,

< Back I Mest > I Cancel |

Check the box next to "Specify a location" and uncheck all others as shown below. Click "Browse" and locate the
driver files. Once the files have been located, click "Next" to proceed with the installation.

fAudd Hew Hardware Wizard

Windows will search for new drivers in its diver database
on wour hard dnve, and in any of the followng selected
lozatonz, Click Mest to start the search,

™ Eoppy disk drives
™ C[D-ROM dive
™ Microsoft Windows Update

V¥ Specify a location:
fC =l
Erowse... |

< Back I Mest > I Cancel |
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Windows may display a message reading "Building driver database" at this point which may take a few
minutes to pass. Once Windows has found the required files, click "Next" to install the device.

Add Mew Hardware Wizard

Windows driver file zeanch for the dewvice:

USE Seral Carwverter

Wfindows i now ready ko install the best diver for this
device. Click Back to zelect a different driver, or click Mest
to continue.

Location of driver:

= C:AYCPDRITIAFTDIEUS.INF

Cancel |

If the driver being installed does not have Microsoft WHQL signature files (.CAT files), the wizard will request a
driver disk to attempt to find them. Click "OK" on the "Insert Disk" message box.

Inzert Disk

Q Fleaze inzert the dig< labeled 'FTDI USE Drivers Dizk', and then click OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

Inzert Disk
The file 'ftdibuz.cat on FTO LUISE Drivers 0K
ﬁ Disk cannat be found.

Cancel
|nzert FTDI USE Drivers Disk in the zelected
drive. and click OF.

Skip File

Dietails...

Coow files from:

IR 8

CAVEE Diivers j Browse...

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other
driver files and should be installed automatically.

11



Windows should then display a message indicating that the installation of the serial converter driver was
successful. The COM port emulation driver must now be installed. Click "Finish" to complete the
installation of the serial converter and proceed to the COM port emulation driver.

Add New Hardware Wizard
g USB Serial Converter

windows has finished instaling the software that your new
hardware dewice requires.

< Back Cancel |

Under Windows 98, the COM port emulation driver will be automatically installed from the same location as the serial
converter driver. However, if the driver is not WHQL certified as explained above for the serial converter driver, the
wizard will ask for the location of .CAT files. Click "OK" on the "Insert Disk" message box.

Ingert Disk

0 Please insert the dis+ labeled 'FTOI USE Drivers Disk!, and then chick OF.

The following window will appear to assist in locating the file. To proceed with the installation without the .CAT file,
click "Skip File".

Insert Dizk | X |

The file 'ftdiport.cat on FTD | USE Drivers ok
é‘ Dizk cannot be faund,

Cancel
Ingzert FTOI LUSE Drivers Digk in the zelected
drive, and click Ok

Skip File

Details...

j Browse...

Cooy files from;
CWCP Drivers

I

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be located with the other driver files
and should be installed automatically.

12



Open the Device Manager (located in "Control Panel\System" then select the "'Device Manger" tab) and select "View
devices by type". The device appears as an additional COM port with the label "USB Serial Port".

Syztem Properties EE |

General Device Manager IHardware F'ru:ufilesl F‘erfu:urmanu:el

& Wiew devices by lype ™ Wiew devices by connection

[+ &2 Keyboard Al

el Modem

g Morikars

iy Mouze

- MultiOCantroller
-8 Metwork adapters
- Ports [COM & LPT)
B j Communications Port [CORT]
F,f PCI ECPERP Part (LPT1)
P PEI Serial Par [cumz]

= II!--E!--E!--E!--H- #

riﬁ‘i ISE Senal F'l:urt [IIIM4]
: ontrallers

I e,

[+ System dewces

I—I niverzal Seral Buz contrallers
-

niverzal Seral Bus contrallers

-
-

Properties | Refrezh | Remove | Prirt... |

[k I Canrel |

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling Instruction
To uninstall drivers, follow the instructions below:

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control PaneNAdd/Remove Programs". Select "FTDI USB-
Serial Converter Drivers" from the list of installed programs.

Add/Bemove Programz Properhies |

Install/Unitstal | windowes Setip I Startup Disk I

% To netall a new program frome a floppy dizk or CO-RORM
g

drive, chck Inztall,
Install...

{'7% The fallowing zoftware can be automaticall removed by
Al

YWirdaowsz, Tao remove a program or to madily its installed
companents, zelect it from the lizt and chick
Add'Remove.

Chinese [Traditional] Language Supy
(FTDI LISB-toSenal Convverter Drrvers
GetRight

InstantCO/DVD J
Internet Explorer Q828750

Japaneze Language Suppart

FemelD river

K.y Drive 1.0
K.orean Language Support j

Add/Bemove... |

ok | Cemeel | dppb |

Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the uninstaller or

"Cancel" to exit.
FTDI Uninstaller v3.0 ]|

If your USB device iz connected, please unplug it now. __

Press Continue to unmstall the diivers, or Cancel to quit.

Continue |

14



When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will change
to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ¥3.0

e =

15



Troubleshooting

1. Windows 98 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USBView utility
from the FTDI website. These can then be checked against the VID and PID entries in the driver INF files. If they do
not match, that driver cannot be installed the VID and PID entries in the driver INF files. If they do not match, that
driver cannot be installed for that device without either re-programming the device EEPROM or modifying the list of
VID and PID numbers in the INF files. Please note that only your own company VID and PID or FTDI's VID (0x0403)
and FTDI PID issued for use by your company should be used in the EEPROM and INF/INI files.

2. Windows 98 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. If installing a D2XX device, selecting not to restart the computer then
unplugging and re-plugging the device may allow the device to function properly without restarting. Restarting the
machine will allow the device to work correctly.

3. Driver installation fails and Windows 98 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed. Please
refer to the example schematics on the FTDI website for standard device configurations. If the error persists,
please contact the FTDI support department.

4. Windows 98 complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device driver is WHQL certified. If
a driver is not certified, there will be no .cat files available.

When installing drivers in Windows 98 or Windows ME, the user is prompted to locate the .cat files if the operating
system cannot find them. If the driver is not certified but you wish to install it anyway, the files may be skipped by
clicking the "Skip" button.

5. Windows 98 complains about missing ftccomms.vxd file

This can occur when the USB Composite driver has been installed if the user has not browsed to the location of the
driver files. If this message appears, do not skip it but browse to the driver file location. The wizard will then be able
to correctly install the device.
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the drivers that are about to be
installed are different from those installed already, the original drivers need to be uninstalled. Please refer
to the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver has been installed the
Found New Hardware Wizard will launch. Click "Next" to proceed with the installation.

Found Mew Hardware Wizard

YWelcome to the Found New

‘\5’ Hardware Wizard

Thiz wizard helps you install a device diver far 2
hardware device.

To continue, click Mest.

< Back I Mext = | Cancel

Select "Search for a suitable driver for my device (recommended)" as shown
below and then click "Next".

Found MNew Hardware Wizard N

Install Hardware Device Drivers e,
A device diver iz a goftware program that enables a hardware device to work with
an operating system,

Thiz wizard will complete the installation for his device:

@ USB <= Serial Cable

& device driver iz a goftware program that makes a hardware device work, Windows
needs diver files for your new device. To lozate driver files and complete the
installation click Mest.

Wihat da you want the wizard o da?
' Search for a suitable driver for my device [recommended]

" Displav a list of the known drivers for this device so that | can choose a specific
diiver

< Back I Mest I Cancel




Check the box next to "Specify a location" and uncheck all others as shown below. Clicking "Next" displays a
dialog box for you to enter to the location of the drivers.

Found New Hardware Wizard i

Locate Driver Files
YWhere do you want Windows bo search for driver files?

Search far driver files for the following hardware device:

C@ USE <-> Serial Cable

The wizard zearches for suitable drivers in itz driver databasze on your computer and in
ary of the fallowing optional zearch locatiors that vou specify.

To start the search, click Mest. [f vou are searching on a floppy digk ar CO-ROM drive,
inzert the floppy digk or CO before clicking Mesxt.

Optional zearch locations:
™ Floppy disk drives
[~ CD-ROM diives
¥ Specify a location
[~ Microsoft Windows Update

¢ Back I Mest » I Cancel |

Found New Hardware Wizard I x|
|neert the manufacturer's installation dizk inta the drive 0k |
g zelected, and then click OF.

Cancel

Copy manufacturer's files from:

|C:ACDM 2.00.00 | | Bowse. |

18



Click "Browse" to display an open file dialog box.

Lok in: [ COM 2.00.00 ~| « @k E-

FTDIPCRT.INF

File narme: IFTDIELIS.INF j Open I
j Cancel |

Files of tppe: |Setup Intarmation [*.inf]

Locate the folder containing the latest drivers downloaded from the FTDI web site above and click "Open", then
click "OK". The PC auto selects the correct INF file, in this case FTDIBUS.INF.

Once Windows found the required driver .INF file, please click "Next" to proceed.

Found MNew Hardware Wizard

Driver Files Search Results
The wizard has finished szarching far driver files for your hardware device.

The wizard found a driver for the following cevice:

@ USE < Serial Cable

Windows found a driver for this device. Ta nstall the driver \Windows found, click Mext.

Lg c:hedm 20000t dibus. inf

< Back I MNest » I Cancel

19



Windows should then display a message indicating that the installation was successful. Click "Finish" to complete
the installation for the serial converter driver for this port of the device. The COM port emulation driver must be

installed after this has completed.

Found New Hardware Wizard

Completing the Found New
%’ Hardware Wizard

N

_\> II5SE Senal Converter

Windows haz finished installing the saftware for thiz device.

To cloze thiz wizard, click Finizh.

¢ Back I Firizh I [Fance|

By examining the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click
"Device Manger...") and viewing by connection ("View > Devices by connection"), the device appears as a "USB

Serial Converter" with an additional COM port with the label "USB Serial Port".

_ini x|

’_.t\ctmn Wig ||#¢|%|@||@
=

Lﬂll_:'l, Inkel{R) 82501EE LPC Interface Controller - 2400
=8, InkeliF) 82501E8 PCI Bridge - 244E

B Inkel{R) PROJ100 VE Network Connection

i BB Realkek RTLE139/810x Family Fast Ethernet NIC

: ,@, Inkel{R) 82501EE SMBus Controller - 2403

L+‘_I 52y Intel(R) 52801EE Ulkra ATA Storage Controllers

L.j =y Intel(R) 52801EE Ulkra ATA Storage Controllers

L‘_l & IntelfR) S2601EE USE Universal Host Contraller - 2402
D 5@. Inkel{R) 82501EE USE Universal Host Contraller - 2404
InteI(R) SZ2801EE USE Universal Host Controller - 2407

:I 5‘&9 LISE Setial Converter
j USE Serial Pork (COMSJ
r_'l é"’ InCEm Mo —ap N
D ;I Intel{R) BZ2365G Graphlcs Controller
1M Intel{R) 82865G\PEIVP Processor ko IfO Controller - 2570
: é Realkek A4C'97 Audio

L[ ystem board
----- |~ Audio Codecs
= Legacy Audio Drivers
|~ Legacy video Capture Devices
L Logical Dsk Manager
% Media Ccntrnl Dewces :_I

-y

Contraller - 240E

20



Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .

21



Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the Add/Remove Programs utility
as this uses the FTDI driver uninstaller program to remove files and registry entries to leave a clean system. Other
methods may leave fragments of the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove
Programs ".Select "FTDI USB Serial Converter Drivers" from the list of installed programs.

% Add/Remove Programs ;lglil
Sort b\,f:l Marmne - i

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click "Continue" to run the uninstaller
or "Cancel" to exit.

FTDI Uninstaller I x|

If your USB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.

When the uninstaller has finished removing the device from the system, the caption on the "Cancel" button will change
to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller I =i

Uninstalling VID_0403&PI1D_6010

Deleting registry entries ...
Deleting files ...

Press Finish to exit.

Finish |

22



Troubleshooting
1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into

the device EEPROM may be found by using the USBView utility from the FTDI web site. These can then be checked
against the VID and PID entries in the driver INF files. If they do not match, that driver cannot be installed for that
device without either re-programming the device EEPROM or modifying the list of VID and PID numbers in the INF
files. Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by
your company should be used in the EEPROM and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting

not to restart the computer then unplugging and re-plugging the device may allow the device to function properly
without restarting. Restarting the machine will allow the device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This

error may appear if a device has insufficient power to operate correctly (e.g. plugged into a bus powered hub with
other devices), or may indicate a more serious hardware problem. Also, it may be indicative of USB root hub drivers
being incorrectly installed. Please refer to the example schematics on the FTDI web site for standard device
configurations.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the FTDI website and unzip them, the
critical files in the driver package are:

ftdi_ser.dll - the VCP driver file
FTDIPORT.inf - user changeable file to allow devices with custom VID and PID combinations to be installed

Copy all of the unzipped files to the \Windows directory on the PDA.

If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or Compact Flash host card), make
sure that it is connected and installed before proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box to direct Windows CE to the
driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file name is incorrect, the driver
will not be found and the device will not function.

£ | unidentified USB D &7 % 12:04

(3 sunday, June 01, 2003

Unidentified USB Device

Enter the name of the device
driver for this device. For
information, see the device
manufacturer's documentation,

<UL,

123/1[2[3]4[5]6[7]|8]9]0]-|=
Tablq|wle[r|t[y|ui]o|p]|l
CAP[a[s[d[f[a[n]j[k[I]:]"
Shift[ 2 [ [c[v[b[n[m[, [.]
ctlai| * [\ ] [4]2

The device installation is now complete. The installation may be verified using the test program available form the
Utilities page of the FTDI website.
Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is
connected for the first time

If the "Unidentified USB Device" dialog is not displayed when the device is connected for the first time, it is likely
that the PDA does not have a USB host capability or that the host is not installed correctly.
Many PDAs require some form of adaptor (USB host cable, presentation pack or Compact Flash USB host card)

to provide the USB host capability that FTDI devices require.

2. "Error installing USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

=,
)

i

| Unidentified USB D < =% 10:36
'

(3 sunday, June 01, 2003
F=] Tap hereto set owner information

m No upcoming appointments

Error installing USE driver
frdi_d2uxx

New Tools Accounts E % E|‘

The driver name has been misspelt - The ".dll" file extension may be required for some platforms - The required
driver files are not in the \Windows directory - The driver file is in the wrong binary format
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

#4F | Unidentified USB D &F % 12:17

(¥ sunday, June 01,2003
F=] Taphereto set owner information

m No upcoming appointments

Error installing USE driver
frdi_ser.dl

New Tools Accounts E % E|‘

The driver name has been miss pelt - The ".dll" file extension may be required for some platforms - The required
driver files are not in the \Windows directory - The driver file is in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the VID and PID combination
programmed into the device. It can also be caused if the INF file has not been copied to the \\Windows directory.

£ |unidentified USB D & o 12:04

(® sunday, June 01, 2003

M | Inidentified USB Device

B Enter the name of the device
= diriver for this device. For

¥ information, see the device

| manufacturer's documentation,

B Enter the name of the davice
driver for this device. For
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One way to check this is to use the Registry editor that comes with Embedded Visual C++ (or a suitable registry
editor on the Windows CE device itself); you may check for the registry settings (Tools > Remote Registry Editor).
With ActiveSync running, connect to your device then look at the registry setting
KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\

.'_.!" Windows CE Remote Registry Editor == B ﬂlﬂ

CEr LT T A

R EEEREEET
# - [=), My Compater A | hame | Dka
= - PCOKET PC 2003 Dereice Al (DeFzas]) {vehse rot set)
P HEEY _CLASEES ROOT
%] | HKEY_CLRRENT LISER
=H ] HEEY_LDCAL_MACHINE
#* ] Comm

= I UsE
-] Chendlereers
(2] FID0_DENSCE_s0I0
EF 2] LnpgChents
= e e

[.
:
-

[POCHET B2 20008 Dewice | EET_LOCAL HACHINDCr eI cadkhernks| LOET_24522]

H

In this case, the entry is 1027_24592, which corresponds to a VID of 0x0403 (1027) and a PID of 0x6010 (24592)
device. If this is not the device to be installed, the message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and PID. For the D2XX drivers,
edit the bold red entries in the following line in the ftd2xx.inf file:

[FtdiHw]
"FTDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the FTDIPORT.inf:

[FtdiHw]
%VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PID_6010
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5. Device can write but cannot read

If the hardware does not work correctly under Windows 2000 or Windows XP then the problem is most likely a
hardware issue. Windows CE is not very tolerant of noisy hardware, so even "good" designs for Windows 2000
and XP may experience problems with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support different bulk transfer sizes.
One method to attempt to resolve this is to reduce In Transfer Size to 64. This is the smallest possible transfer size
and will have a severe effect on performance, but should resolve most other issues. Larger values may be tried to
improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can result in the device running at
a different Baud rate to the one intended. The Baud rate can be verified easily by transferring data from PDA/target
to HyperTerminal.

Some host device drivers have been seen to lose packets of data which would also cause this problem.

7. Driver isn't sending or receiving any data
Sending and receiving data can be tested with an application such as VCPTest. However, this will not highlight

problems due to incorrect Baud rates. To check for the wrong Baud rate being set, try to transfer data from the
PDA/target to and from HyperTerminal.
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Windows XP Installation Guide

1. Installing Via The Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers that are about to be installed
are different from those installed already, the original drivers need to be uninstalled. Please refer to the Uninstalling
instruction.

Download the latest available drivers from the FTDI web site and unzip them to a location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from the Internet. This can be
done by either removing the network cable from your PC or by disabling your network card by going to the "Control
Panel\Network and Dial Up Connections", right clicking on the appropriate connection and selecting "Disable" from
the menu. The connection can be re enabled after the installation is complete. This is not necessary under Windows
XP SP 2 if configured to ask before connecting to Windows Update. Windows XP SP 2 can have the settings for
Windows Update changed through "Control Panel\System" then select the "Hardware" tab and click "Windows
Update".

Connect the device to a spare USB port on your PC. If there is no available Internet connection or Windows XP SP
2 is configured to ask before connecting to Windows Update, the screen shown in Figure 2.1 is displayed. Select
"No, not this time" from the options available and then click "Next" to proceed with the installation. If there is an
available Internet connection, Windows XP will silently connect to the Windows Update website and install any
suitable driver it finds for the device in preference to the driver manually selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
‘windows will zearch far current and updated software by

loaking on pour computer, on the hardware installation CO', or on
the Windows Update Web site [with pour permission)

Oniling privacy information

Can Windows connect to “indows Update to search for
software?

(O es, this time only
() Yes, now and gvery time | connect a device

®

Click Mext to continue.

Figure 2.1

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
Figure 2.3 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click
next to proceed.

Found New Hardware Wizard

Thiz wizard helps pou install software for:

USE Serial Converter

) If your hardware came with an installation CD
2 or floppy disk, insert it now.

“What do you want the wizard to do?

() Install the software automatically [Recommended)

Click Mest to continue.

[ < Back ” Mest » I[ Cancel

Figure 2.2

Found New Hardware Wizard

Please choosze pour zearch and inztallation options. .

(%) Search for the best driver in these locations.

Uze the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[] Search removable media (floppy, CO-ROM...)
Include this location in the search:

CACDM 2.02.04 w!| [ Browse |

(O) Don't search. | will choose the diver to install

Chooze thiz option to select the device driver from a list. ‘Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ][ Mest » ][ Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.4 will be displayed unless installing a Microsoft WHQL certified driver. Click on
"Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file signature warnings, no
message will appear.
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The screen shown in Figure 2.5 will be displayed as Windows XP copies the required driver files.

Hardware Installation

| ] E The software you are inztalling for this hardware:
L
IUSE Serial Converter

haz not pazsed Windows Logo testing to verfy itz compatibility with
thiz version of Windows. [Tell me why this testing is impartant]

Continuing your installation of thiz software may impair
or destabilize the correct operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ LContinue Anpway ] | STOF Installation J

Figure 2.4

Found New Hardware Wizand
Please wait while the wizard installs the software. .. .

% USE Serial Converter

=7, £

fred2xs. dil

Tao CWWINDOWS systern32

CCICCC e )
Figure 2.5

Windows should then display a message indicating that the installation was successful (Figure 2.6). Click "Finish" to
complete the installation for the first port of the device.
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The Found New Hardware Wizard will launch automatically to install the COM port emulation drivers. As above,
select "No, not this time" From the options and click "Next" to proceed with the installation (Figure 2.7).

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software far:

@ USE Serial Corverter

Click Finizh to close the wizard.

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
“Windows will search for current and updated software by

loaking on wour computer, on the hardware installation CD, or on
the 'Windows Update \Web site (with your permizsion)

Online privacy information

Can "indows connect to Windows Update to search far
software?

(O Yes, this time only

() ez, now and gvery time | connect a device

®

Click. Mest bo continue.

Nest » Cancel

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below and then click "Next".
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Select "Search for the best driver in these locations" and enter the file path in the combo box ("C:\CDM 2.02.04" in
figure 2.9 below) or browse to it by clicking the browse button. Once the file path has been entered in the box, click
next to proceed.

Found New Hardware Wizard

This wizard helps you install software for:

USE Serial Port

'\') If your hardware came with an installation CD
i or Hoppy disk. insert it now.

‘what do you want the wizard to do?

() Install the software automatically [Fecommended)
(&)iinstall fram a st or speciiic location [Advanced}

Click Mext to continue.

[ < Back H Next > ][ Cancel

Figure 2.8

Found New Hardware Wizard
Please choosze pour zearch and inztallation options. .

Uze the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[] Search removable media (floppy, CO-ROM...)
Include this location in the search:

CACDM 2.0204 v

(O) Don't search. | will choose the diver to install

Chooze thiz option to select the device driver from a list. ‘Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ” Mest » I[ Cancel

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are about to be installed, the
message dialogue shown in Figure 2.10 will be displayed unless installing a Microsoft WHQL certified driver. Click
on "Continue Anyway" to continue with the installation. If Windows XP is configured to ignore file signature warnings,
no message will appear.
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The screen shown in Figure 2.11 will be displayed as Windows XP copies the required driver files.

Hardware Installation

1 E The zoftware you are ingtalling for this hardware:
L
USE Serial Port

haz naot passed Windows Logo testing to verify it compatibility with
this werzion of Windows. [Tell me why this testing is important)

Continuing your installation of this software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microzsoft strongly
recommends that you stop thiz installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Lontinue Anwway ] | STOP Installation J

Figure 2.10

Found News Hardware Wizard
Pleasze wait while the wizard installs the software. .. .

/S LUSE Serial Port

= ]
ftzemiZ.di
To CYWINDODWS aysten32
[ 1
Figure 2.11

Windows should then display a message indicating that the installation was successful (Figure 2.12). Click "Finish"
to complete the installation for the first port of the device.

The procedure for installing the second port is identical to that for installing the first port from the first screen of the

Found New Hardware Wizard for the USB Serial Port device. If the driver is Microsoft WHQL certified, this would be
done automatically.
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Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manger") and select "View > Devices by Connection”, the device appears as a "USB Serial Converter" with an
additional COM port with the label "USB Serial Port" (Figure 2.13).

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software far:

Fif USE Serial Port
=
i

Click Finizh to close the wizard.

Figure 2.12

Device Manager

Ele Acion Wiew Help

S 2@ &
'§ ACPI Fixed Feature Button ~
8 Genuine Intsl(R) CPU 2160 @ 1.80GHz
# Genuine Intel(R) CPU 2160 @ 1,80GHz

= % PCIbus

#- % Intel(R) 946GZ Express Chipset Famiy
- g Intel(R) 2801 PCI Bridge - 244E
Intel(R) 828016 (ICH7 Family) SMBus Contraller - 2704
3 Intel(R) 628016 (ICHT Family) USB Uriversal Host Contraller - 2706
InteliR) &2801G (ICH7 Family) LUSE Universal Host Controller - 27C9
L.
USB Serial Corwvertar
A U8 Serial Part (COMa)
[+ Cbpas ST O5E Universal Host Controller - 27CA
3 Intel(R) 628016 (ICHT Family) USB Uriversal Host Contraller - 2706
®
5

Intel{R) 628016 (ICH? Family) USBZ Enhanced Host Controller - 27CC
¢ InteliR.) 82801GB/GR (ICH? Family) LPC Interface Controller - 2765
+ -2 Intel(R) 52801 GE{GRIGH (ICH7 Family) Serial ATA Storage Controller - 27C0
74 InteliR) 946GZ(PL/GL PCI Express Root Port - 2671
¢ Intel{R) 946GZ/PLIGL Processor to IjO Controller - 2970
+ ¢ Microsoft LA Bus Driver For High Definition Audia
¢ Motherboard resources ~

Figure 2.13

evice Manager

File Action Yew Help

H & 2m A

= ¥ PCIbus -
£ :2 Intel{R) 946GZ Express Chipset Family
# iy Intel{R) 82801 PCI Bridge - 244E
Inkel{R) §2801G (ICHT Family) SMBus Controller - 2708
+ Intel(R) B28016 (ICH7 Family) LISE Liniversal Host Controller - 27C8
4 Intel(R) 828016 (ICH7 Farily) LISE Universal Host Contraller - 2709
= Intel(R) B28016 (ICH7 Family) LISE Uiniversal Host Controller - 27€4

% LUSE Composite Device
= &% UISE Serial Converter A
- ¥ use serial Part (Com3)
= &% USE Serial Converter B
¥ use Serial Part (CamM4)

+ Eaniaya =
£ g Intel{R) 828016 (ICH7 Family) USBZ Enhanced Host Contraller - 7CC
1y Intel{R) 62601GBIGR (ICHT Famiy) LPC Interface Controller - 2786
+ =) Intel(R) 82801 GEIGR/GH (ICH7 Family) Serial ATA Storage Controller - 700
) InkeliR) 946GZJPLIGL PCI Express Raoot Port - 2971
¢ Intel{R) 946GZ/PLIGL Processor to T/O Controller - 2970
+ ) Wicrasaft UAA Bus Driver For High Definition Audio
¢ Motherboard resources v

Figure 2.14
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2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the driver package using the
Microsoft Driver Install Frameworks (DIFx) tools. The simplest tool provided is the Driver Package Installer (DPInst).
When placed in the same directory as the INF files for the driver package, simply run DPInst.exe and the certified
driver package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files. DPInst has separate
executables for 32bit and 64bit installation. This means that if a single solution is desired for 32bit and 64bit
systems, the developer must be able to detect which version of DPInst is required for the system the driver is being
installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install the driver from the
Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in 2.1 Installing Via The New
Hardware Wizard, except that the “Yes, this time only” or “Yes, now and every time | connect a device” option
should be selected on the first screen of the wizard when asked if Windows Update should be checked for a driver.
If the wizard finds a matching driver on Windows Update, the driver will be automatically downloaded and installed
for the device.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed using the Device Manager by
simply right clicking on the device and selecting "Uninstall". This will delete the associated registry entries for that
device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually or by using a custom
application. OEM INF and PNF files are located in the Windows\Inf directory and can be identified by searching for a
VID and PID string matching the device installed e.g. VID_0403&PID_6001. Once the matching OEM INF files are
found (e.g. oem10.inf for FTDIBUS.INF and oem11.inf for FTDIPORT.INF), the corresponding PNF files must also
be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located in the Windows\System32 and
Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

If the VCP driver has been installed, the COM port driver should be removed before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the driver files are deleted while other installed devices still require them those devices will not work correctly. This
can be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device
manager to show phantom devices. This can also allow a virtual COM port to be uninstalled if the bus layer has
been removed first. Instructions on how to display phantom devices are given in the Advanced Driver Options
application note.
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Troubleshooting
1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View
utility from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either reprogramming the device EEPROM
or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI PID issued for use by your
company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware Wizard is trying to copy it. This
usually occurs with the FTD2XX.DLL file. Selecting not to restart the computer then unplugging and re-plug the
device may allow the device to function properly without restarting. Restarting the machine will allow the device to
work correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error may appear if a device has
insufficient power to operate correctly (e.g. plugged into a bus powered hub with other devices), or may indicate a
more serious hardware problem. Also, it may be indicative of USB root hub drivers being incorrectly installed.
Please refer to the example schematics on the FTDI web site for standard device configurations. If the error persists,
please contact the FTDI support department.
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4. Windows XP Displays An Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been configured to block the
installation of any drivers that are not WHQL certified.

Hardware Installation

@ The software pou are installimg for thaz hardweare:
USE Serial Converter

has not passed Windows Logo testing to verify its compatibility
with this version of Windows, [Tell me why thiz testing is important]

This hardware will not be installed. Contact powr system
adrmiristrator.

Figure 4.1

Two options are available to successfully install the device. Either a certified version of the driver can be installed
(if available) or the driver signing options can be changed to either warn or ignore to allow the installation to
complete.

To change the current driver signing setting, go to "Control Panel\System", click on the "Hardware" tab and then
click "Driver Signing". The desired signing option may then be selected.
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Windows VISTA (Win 7, 8, 8.1, 10) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, 8, 8.1, 10) will silently connect to the Windows
Update website and install any suitable driver it finds for the device in preference to the driver manually selected. If
no suitable driver is automatically found then the following procedure should be followed.

B e

Windows needs to install driver software for your TTL232R
Tester

@ Locate and install driver software {recommended)

Windows will guide you through the process of installing driver software
for your device,

* Ask me again later
Windows will ask again the next time you plug in your device or log on.

' Don't show this message again for this device
Your device will not function until you install driver software,

Cancel

When locate and install driver software (recommended)" is selected the following screen will appear. Note: the text
“TTL Tester” is replaced with the description of the customer hardware.

@ || Found New Hardware - TTL232R Tester
Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software,

% Idon't have the disc. Show me other options.
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Select “l don’t have the disk. Show me other options” The next screen will appear.

&3 L Found New Hardwore - TTL232R Tester

Windows couldn’t find driver software for your device

2 Check for a solution
Windows will check to see if there are steps you can take to get your device

working.

< Browse my computer for driver software (advanced)
Locate and install driver software manually.

”. The next screen will appear.

Select “Browse my computer for driver software (advanced

K3 . Found New Hardware - TTL232R Tester
Browse for driver software on your computer

Search for driver software in this location:
mm Desktop\CDM 2.00.00 (Certified)

[ Include subfolders

[ Next ]l Cancel J

Browse to the folder where the CDM driver has been stored (when uncompressed) and press “Next”

The example shown above uses a folder on the desktop.
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The next screen will appear.

) . FoundMNew Hardware - TTL232R Tester

Installing driver software...

This screen will automatically complete and then change to the one below:

Found MNew Hardware - USE Serial Converter
The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

USE Serial Converter

Close

The bus layer of the driver is now installed.
After the driver is installed it is important to determine which COM port has been assigned to the device for
configuring the application that will use the device.

42



Open the Device Manager (located in "Control Panel\System" then select the "Hardware" tab and click "Device
Manager") and select "View > Devices by Connection", the device appears as a" USB Serial Converter" with an
additional COM port with the label "USB Serial Port".

.= Device Manager = e =
File Action View Help

& I HZ &

7-{& Computer

-y Disk drives

| B, Display adapters

gty DVD/CD-ROM drives

=4 Floppy disk drives

< Floppy drive controllers

"4% Human Interface Devices

€ IDE ATA/ATAPI controllers

§ IEEE1394 Bus host controllers

2= Keyboards

fj Mice and other pointing devices

K Monitors

|- &¥ Network adapters

| Kl Portable Devices

=75 Ports (COM &L LPT)
'Y Communications Port (COM1)
Y2 Printer Port (LPT1)
3" USB Serial Port (COM3)

4 D Processors

--% Sound, video and game controllers
4, High Definition Audio Device

s B s O R B

O o R Y O

7 €F Storage controllers
1% System devices
& ' Universal Serial Bus controllers

This screen shows the device connected to COM3.

Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered unusable due to Windows
Resource Protection preventing the executable from deleting driver files and associated registry values. Vista will
only allow the system itself to modify files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be removed using the Device
Manager by simply right clicking on the mouse and selecting "Uninstall". This will delete the associated
registry entries for that device only. Vista provides an automatic method to delete driver files via a check
box to "Delete the driver software for this device" on the uninstall dialog box.

- Confirm Device Uninstall

USE Senal Converter
L

Waminag: You are about to uninstall this device from your system.

| ok || concel |

Windows 2000, XP and Server 2003 do not have this check box, so driver files and OEM INF and PNF files
must be removed manually or by using a custom application.

Some points to note about the new uninstallation method:

If the VCP driver has been installed, the COM port driver should be uninstalled before the bus driver. If the bus is
removed first, the COM port will no longer appear in the Device Manager.

If the files are deleted while other installed devices still require them those devices will not work correctly. This can
be fixed by right clicking the device and selecting "Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed by setting the device

manager to show phantom devices. This also allows a virtual COM port to be uninstalled if the bus layer has been
removed first.
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Troubleshooting

1. Windows VISTA (Win 7, 8, 8.1, 10) can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not match those listed in the INF
files for the driver. The VID and PID programmed into the device EEPROM may be found by using the USB View
utility from the FTDI web site. These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either reprogramming the device EEPROM
or modifying the list of VID and PID numbers in the INF files. Please note that only your own company VID and PID
or FTDI's VID (0x0403) and FTDI PID issued for use by the customer should be used in the EEPROM and INF files.

End customers should obtain modified drivers from the OEM of the device, and not necessarily edit the files
themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred to as "phantom devices".
These devices are not usually displayed in the device manager, but can be made to be displayed as though they are
attached. This allows device properties to be changed or devices to be uninstalled via Device Manger even though
the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required. Open "Control Panel >
System" then select the "Advanced" tab and click "Environment Variables". In the System Variables section
(NOT THE USER VARIABLES SECTION), click "New..." to display the following window:

Edit System Variable |25
Variable name: DevMar_Show_MonPresent_Devices
Variable value: 1]
| OK | | Cancel |

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and set the value to 1, then
click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware" tab and click "Device

Manager...", or "Control Panel > Device Manger" in Vista) and select "View > Show Hidden Devices".
Device Manager will then show all hidden and phantom devices available on that PC as shaded.
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3. Windows Vista (Win 7, 8, 8.1, 10) shows a warning that the driver is not certified

If the driver is not certified then a pop up window such as shown below will be displayed.

@ Windows Security

@ YWindows can't verify the publisher of this driver software

=» Don't install this driver software
You should check vour manufacturer's website For updated driver software For vour
device,

<% Install this driver software anyway
only install driver software obtained from your manufacturer's website or disc,
Unsigned software from okther sources may harm your computer or steal information,

;i See details

If you are certain of the source of the driver the warning can be ignored and you can continue installation
by selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied by FTDI will work with VID
0403 and PID 6001 for FT232 devices.

If you have a product where the manufacture has customized the driver but has not recertified it, then the driver will
not load. You should contact your vendor to determine if they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the hard disk. The driver is
now available in disk image (.dmg) format. Run the installer by double clicking on the FTDIUSBSerialDriver.dmg
icon.

"®@O N Install FTDIUSBSerialDriver Kernel Extension

E e | Welcome to the Mac OS5 X Installation Program. You will be
6 Introduction guided through the steps necessary to install this software.

[ ] Re\&j‘ﬂ Me

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

@ Select Destination
@ Installation Type

® Installing

® Finish Up /

Gomer

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.

"@O N Install FTDIUSBSerialDriver Kernel Extension

O Introduction
O Read Me

© Select Destination

Install Software

O Installation Type
@ Installing The software was successfully installed

© Finish Up /|

Click Restart to finish installing the software.

Go Back
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When the computer has rebooted, plug in the device. If the device is installed properly, you will see entries in the
/dev directory:

/dev/cu.usbserial-XxxXxxxxxx
/dev/tty.usbserial-xxxxxxxx

Where xxxxxxxx is either the device's serial number or, for unserialized devices, a location string that depends on
which USB port your device is connected to. The Terminal application can be launched by selecting Go >
Applications > Utilities > Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-I

If you run the application System Preferences and select Network (Go > Applications > System Preferences >
Network), you should see the text "New Port Detected".

New Port Detected

i w A new network port has been detected:
usbserial-1B22

Please verify that it is configured correctly, then

press Apply Now to activate it

Click OK and select Network Port Configurations from the show list. The new port can be enabled from this screen by
checking the on box and clicking Apply Now.

Network =

Location: Automatic i

Show: Network Port Configurations %

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configuratiuns

B  ushserial-1B22 P
™  Internal Modem —— |

E Built-in Ethernet rr—
(" Delete... )
(" Duplicate )

@

-] - R = o
ﬂ;ﬂj‘ Click the lock to prevent further changes. [ Assistme... ) [ Apply Now )
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At this point, it is possible to exit Network and use the device as a COM port. If you wish to set the device up a
modem for an Internet connection, select the new port from the Show list to display the window below.

~

:B e o Network (=]

« =y @

Show all | Displays Sound | Network | Startup Disk

ar

Location: | Automatic [

= TS

Show: usbserial-1822 J

ar

[ PPP | TCP/IP | Proxies = Modem !

Service Provider: (Optional)

Account Nama:

Password:

Telephone Number:

Alternate Number: (Optional)

[ Save password
Checking tiis box allows all users of this computer to
access this Internet account without entering a password.

(PPF Options... ') l: Dial Now. .. \,'I

ﬂ—g Click the lock to prevent further changes. ¢ Assist me... | Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not know the required details,
contact your Internet service provide

Please note:
1. For multiple-port converter, each port has to be installed with the driver individually, i.e. you have to repeat this
installation procedure 2 times (2-port converter) or 4 times (for 4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download the updated or appropriate
versions from FTDI Web site www.ftdichip.com/Drivers/VCP.htm .
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a reserved username that has
the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the following commands at the
command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select Network. Selecting Network
Port Configurations from the Show menu will display the port as greyed out. Select the uninstalled port and click
Delete. Confirm the deletion to remove the port.

r — e |
_6 e 0 Network =

« @ H G

show All Displays Sound | Metwork Startup Disk

-

Location: | Automatic

H
H

Show: Metwork Port Configurations

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On | Port Configurations
__!  usbserial-1B22 e
E Internal Modem '\L"
Eq Built-in Ethernet [ Edit ';,
LU
(" Delete... )
Duplicate
&)
n . P
[f™]  Click the lock to prevent further changes. (_ Assist me... ) Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X. This can be accessed by
going to the Finder and selecting Applications from the Go menu, then open the Utilities folder.
Select USB under Hardware in the pane to the left and then select the appropriate device from the USB Device
Tree. In the screen shot below (from OS 10.3), the device has a device ID given by:

Vendor Name: FTDI

Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

rﬁ o6 System Profile
Andy's eMac 10/01/2005 08:37
[ Contents || 'USE Device Trea
W Hardware USE Bus
Memory ¥ USE Bus
PCI/AGP Cards ¥ Hub in Apple Extended USB Keyboard
ATA USB <-> Serial
SCEI Apple Optical USB Mouse
USB Apple Extended USB Keyboard
FireWire USE Bus
AirPort Card USE High-Speed Eus
Modems
¥ Software
Applications -
Extensions 'USB <-> Serial:
Network
Logs ~ Vendor Name:  FTDI
Speed: Up to 12 Mb/sec
Product ID: 24577 (36001)

Bus Power (mA). 100

]

If the device does not work after installing the driver, it is likely to be because the PID is not supported by the driver.
If this is the case, contact FTDI Support with the PID that needs to be added to the driver. If the VID is not 0x0403, it
is likely that the device is not an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port
Detected" is not displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable the EEPROM so that the
device reverts to its default device ID, then replug. To get support for your device ID built into FTDI
USBSerial Driver, contact FTDI quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported
in FTDI USBSerial Driver

An ownership or permissions problem is preventing the system from making the device accessible. Check
that the driver is owned by root and wheel. The most common symptom is the group for FTDI USBSerial
Driver is not wheel. To change the group, login as root and perform the following script in a Terminal
window (Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.
4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities > Terminal .The terminal
window is equivalent to a DOS prompt in Windows.
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Regulatory Compliance

Disclaimer

Information in this document is subject to change without notice. The manufacturer does not make any representations or
warranties (implied or otherwise) regarding the accuracy and completeness of this document and shall in no event be liable for
any loss of profit or any other commercial damage, including but not limited to special, incidental, consequential, or other damages.
No part of this document may be reproduced or transmitted in any form by any means, electronic or mechanical, including
photocopying, recording or information recording and retrieval systems without the express written permission of the manufacturer.
All brand names and product names used in this document are trademarks, or registered trademarks of their respective holders.

CE Certification
This equipment complies with the requirements relating to electromagnetic compatibility.
It has been manufactured under the scope of RoHS compliance.

FCC Compliance Statement

This equipment generates and uses radio frequency and may cause interference to radio and television reception if not installed
and used properly. This equipment has been tested and found to comply with the limits of a Class B digital device, pursuant to
part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation.

You are cautioned that changes or modification not expressly approved by the party responsible for compliance could void your
authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept any interference received, including interference that may cause undesired operation

ﬁ WEEE (Waste of Electrical and Electronic Equipment),
e Recycling of Electronic Products

In 2006 the European Union introduced regulations (WEEE) for the collection and recycling of all waste electrical and electronic
equipment. It is no longer allowable to simply throw away electrical and electronic equipment. Instead, these products must enter
the recycling process.

Each individual EU member state has implemented the WEEE regulations into national law in slightly different ways. Please follow
your national law when you want to dispose or any electrical or electronic products. More details can be obtained from your
national WEEE recycling agency.
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